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1. Introduction 

The Clay Tectonics project (2023-2025) is a cSBO-project funded by Flanders Innovation and 

Entrepreneurship (VLAIO) through the Blue Cluster (DBC). The project aims to investigate the nature and 

origin of Clay Tectonic Features (CTFs) in the Kortrijk Formation (Early Eocene) within the planned Princess 

Elisabeth Zone (PEZ) for Offshore Windfarms (OWF), as well as their potential influence on the foundation 

design and installation of offshore wind turbines. The project partners (VLIZ, UGent, VUB - OWI-Lab) will 

apply a multidisciplinary approach, combining geophysical, geological and geotechnical methods. 

The scope of the first work package in this project (WP1) is to design and execute an innovative field 

measurement and processing strategy to generate ultra-high-resolution, pseudo-3D1 acoustic/seismic 

data volumes, in which the different types of CTFs occurring in the Kortrijk Formation can be adequately 

visualised. In a first deliverable (D1.1; Mestdagh et al., 2023), the selection of the location for these 

pseudo-3D volumes was documented, including a discussion about the constraints and used selection 

criteria; the thus selected survey areas (block A, B and C)2 and suggested track patterns are shown in 

Figure 1 and summarized in Table 1. 

Table 1. Overview of the survey grids selected for pseudo-3D seismic/acoustic profiling, as shown in Figure 1. See 
Figure 1 for the definition of the grid corners for which coordinates are given in this table (in WGS84). 

Name Location Dimensions Line spacing Priority 

Block A 

SE side of central PEZ 

1.6 x 1.6 km 
40 m (in- and 

crosslines) 
1 

1 51° 26.67702' N 2° 27.39218' E 

2 51° 26.18736' N 2° 28.52902' E 

3 51° 26.89773' N 2° 29.31281' E 

4 51° 27.38752' N 2° 28.17581' E 

Block B 

S side of northern PEZ 

2.5 x 2.5 km 
50 m (in- and 

crosslines) 
1 

1 51° 35.38599' N 2° 30.30605' E 

2 51° 34.75705' N 2° 32.22025' E 

3 51° 35.94934' N 2° 33.23057' E 

4 51° 36.57856' N 2° 31.31576' E 

Block C 

NW side of central PEZ 

2.4 x 3 km 
60 m (in- and 

crosslines) 
2 

1 51° 30.92075' N 2° 23.47615' E 

2 51° 32.06041' N 2° 25.31683' E 

3 51° 31.14153' N 2° 26.77820' E 

4 51° 30.00213' N 2° 24.93755' E 

 

 

 

 
1 The term pseudo-3D is used in this document, since the adopted approach was to collect dense grids of 2D seismic 
and acoustic profiles in in- and crossline direction, with line spacings that are small enough to generate adequate 3D 
representations of the envisaged subsurface features (as opposed to full 3D seismic/acoustic systems that are 
designed to generate 3D volumes in a single pass).  

2 It is already noted that, although originally three pseudo-3D sites were planned (as outlined in D1.1), a fourth 
pseudo-3D block (block D) was completed in the course of the project. This is further discussed in sections 2.2 and 
2.3. 



 

Figure 1. Map showing the selected study sites for pseudo-3D seismic and acoustic profiling within the Princess 
Elisabeth OWF, including a detailed line planning for each of the selected areas (block A, B and C), as suggested in 
Clay Tectonics project deliverable 1.1 (Mestdagh et al., 2023). 

The goal of this second deliverable (D1.2) is twofold: 

(i) To describe the adopted survey and data collection strategy for the selected survey 

tracks/areas (Figure 1; Table 1), focusing on how the available geophysical instrumentation was 

configured and used to optimize the amount and quality of data visualising CTFs (section 2). 

(ii) To provide an overview of how the acquired seismic and acoustic data were subsequently 

processed with the aim to facilitate the data interpretation and analysis addressed in work 

package 2 of the project (section 3). 

 



2. Acquisition of seismic and acoustic data at sea 

2.1. Available geophysical methods and systems 

Before outlining the survey and data collection approach, this section first details the geophysical methods 

and specific systems that were used in WP1 of the Clay Tectonics project to perform the desired 

measurements at sea. 

2.1.1. Sub-seabed information 

Sub-seabed information is typically acquired using seismic and/or acoustic geophysical systems. These 

systems come with a trade-off between depth penetration and vertical (layer) resolution, determined by 

the frequency content of the emitted signals (a higher frequency content leads to a higher vertical 

resolution but shallower depth penetration, whereas a lower frequency content allows to increase the 

depth penetration at the cost of lowering the vertical resolution). Given that the depth interval of interest 

(i.e. the occurrence of the Kortrijk Formation and associated CTFs) is rather wide (ranging from 0 to 

>100 m below sea floor), a combination of seismic/acoustic techniques is recommended in order to 

retrieve both deep and shallow subsurface information at the highest possible resolution. Therefore, both 

acoustic sub-bottom profilers and (sparker) seismic systems are used in the Clay Tectonics project. 

Acoustic sub-bottom profiling 

Acoustic sub-bottom profilers allow to image strata, structures and objects in the shallow subsurface 

(upper meters to tens of meters) with deci- to centimetric vertical resolution. Two types of sub-bottom 

profilers have been considered and tested for the detection of CTFs in the selected study areas: 

(i) Parametric sub-bottom profiler (SBP): the Innomar Quattro system of VLIZ is a multi-transducer 

parametric sub-bottom profiler consisting of four small (21 x 21 cm) transducers (Figure 2). The multi-

transducer set-up provides a certain versatility, as the transducers can be mounted and configured in 

various ways, depending on the scope of the survey. For the imaging of CTFs in the Princess Elisabeth 

OWF, only the ‘single beam mode’ is considered, in which the transducers are mounted in a square (2x2) 

array and ping/receive simultaneously (with the received signals being summed), in order to optimise the 

penetration and signal-to-noise ratio. The system is typically mounted on a pole and can be deployed from 

small to large vessels using an over-the-side system (Figure 2). The system emits primary high frequencies 

of ca. 100 kHz, which results in a secondary low frequency band of 2 – 22 kHz with (user-selectable) center 

frequencies in the range of 4 – 15 kHz. Making use of the parametric effect, narrow beam widths are 

achieved (ca. 1.5° for the 2x2 transducer array), which, together with a high ping rate (between 10 and 20 

pings/s for the water depths in the PEZ), allows small footprints and a high spatial resolution. The (primary) 

source level is max. 245 dB (re 1 µPa at 1 m).  

A second option for parametric sub-bottom profiling is the hull-mounted Kongsberg TOPAS PS18 system 

on board RV Belgica. This system emits primary high frequencies around 18 kHz, resulting in user-

selectable secondary low frequencies between 0.5 and 6 kHz. As such, this instrument offers a deeper 

penetration than the Innomar Quattro, yet with a ping rate of maximum 5 pings/s and beam width around 

5°, it has a lower horizontal resolution. The (primary) source level is max. 243 dB (re 1 µPa at 1 m). 

(ii) Chirp sub-bottom profiler: the Autonomous Underwater Vehicle (AUV) Barabas of VLIZ (Figure 3) is a 

modular, torpedo-shaped vehicle (Teledyne Gavia) with a depth rating of 1,000 m. One of the available 

modules is a Benthos chirp SBP, which emits a linear sweep between 14 and 21 kHz, with a (user-



selectable) sweep length between 1 and 30 ms and a ping rate of up to 15 pings/s. The beam width of 

chirp systems is significantly higher than for parametric SBPs (for this specific chirp module around 40°), 

but reducing the altitude of the AUV above the sea floor provides a chance to keep the footprint relatively 

limited. The source level can be adjusted by changing the relative transmit power index (0 = highest 

power; 7 = lowest power). 

 
Figure 2. Pictures showing the Innomar Quattro parametric sub-bottom profiler: (A) View on the four transducers 
mounted in a square array (single beam mode). (B) Deployment of the instrument using an over-the-side system on 
board RV Simon Stevin. (C) Topside unit. 

 
Figure 3. (A) Picture of the modular AUV Barabas (Teledyne Gavia) of VLIZ equipped with the Side Scan Sonar module. 
(B) Schematic configuration of the vehicle when used for testing the chirp sub-bottom profiling module in the PEZ. 
The length of the vehicle in this configuration is 3.02 m with a diameter of 0.2 m. (C) Schematic configuration of the 
vehicle when used for testing the side scan sonar module in the PEZ. The length of the vehicle in this configuration is 
2.87 m with a diameter of 0.2 m. 



Sparker seismic reflection profiling 

Seismic reflection profiling using sparker sources allows to image the upper tens to hundreds of meters 

of the subsurface with a vertical resolution of several decimetres to a few meters. The source deployed 

for the measurements in the Clay Tectonics project is a GSO-360 sparker (Figure 4), in combination with 

an Applied Acoustics Csp-Nv power supply unit (both available within VLIZ). The energy output is user-

selectable between 50 and 2400 J, and by adjusting the amount of used sparker tips (either 90, 180, 270 

or 360), the amount of energy per tip (determining the achieved penetration/resolution) can be further 

finetuned. The shot rate is also user-selectable, provided that the charging rate of the power supply unit 

(max. 2000 J/s) is respected. On the receiving end, two types of streamers are available: (i) a SIG dual-

channel streamer (channel 1 containing 8 hydrophones at 15 cm, channel 2 containing 10 hydrophones 

at 30 cm, 2.85 m channel spacing), and (ii) a SIG 24-channel streamer (every channel containing 4 

hydrophones at 20 cm, 2 m channel spacing). The data is recorded using a Delph analogue acquisition unit 

(24-bit). The sparker source and streamer(s) can be deployed from coastal or oceanographic vessels, and 

are both towed (typically several tens of meters) behind the ship. 

 

Figure 4. (A) Picture of the GSO-360 sparker of VLIZ. (B) Picture of the bottom of the GSO-360 sparker, showing 4 
rows of electrodes (in red sleeves). (C) The SIG 24-channel streamer (on the left, transparent section) and GSO-360 
sparker (on the right, with orange high-voltage cable) on the deck of RV Belgica before deployment.  



2.1.2. Seabed information 

Although the primary focus of the Clay Tectonics project is visualising CTFs in the subsurface, it is also 

worth exploring if these features have an expression on the seafloor itself. To investigate this, the 

following seafloor-scanning methods/systems have been considered and tested: 

(i) Multibeam echosounder (MBES): multibeam echosounders are acoustic systems used to map the 

seafloor. RV Simon Stevin and RV Belgica each have a hull-mounted Kongsberg EM2040 system, which 

provides both bathymetric information (bottom topography) and backscatter information (giving an 

indication about the seabed composition). In addition, water column data can be recorded as well. 

(ii) Side scan sonar (SSS): this is another acoustic seabed scanning method which uses sideways projected 

pulses, generally from a deep-towed sonar (‘fish’) connected to a vessel. More recently, side scan sonar 

modules for integration in autonomous vehicles have become available, like the Klein UUV-3500 system 

in AUV Barabas (Figure 3C). Although principally used for 2D visualisation of objects and structures on the 

seafloor, bathymetric information can also be derived from this sensor through interferometric 

calculations. 

 

2.2. Planned survey and data acquisition strategy 

Given the goal of WP1, the selected areas/tracks (Figure 1; Table 1) and the considered methods/systems 

outlined above, the following data collection strategy was developed: 

(i) Step 1: perform on-site parameter tests to establish the optimal acquisition settings (e.g. frequency, 

source energy) for the imaging of CTFs in the representative pseudo-3D blocks with the parametric SBP 

and sparker seismic system. 

(ii) Step 2: once the optimal acquisition settings have been determined, survey the pseudo-3D areas/grids 

as designed in D1.1 (Figure 1; Mestdagh et al., 2023) according to following plan: 

- Simultaneous ship-based measurements with parametric SBP and sparker seismic system (~3 kn 

survey speed), using the optimal acquisition settings determined in step 1 (earlier tests have 

demonstrated that both systems can run in parallel without major interference); 

- Recording of sparker reflection seismics with both dual- and multi-channel streamer, such that 

all planned survey tracks have sparker data but with adjacent tracks alternating between a dual- 

and multi-channel recording (after all, towing the streamers at the same time poses a too high 

risk for entanglement or contact with the sparker); 

- Simultaneous recording of MBES data while performing the sub-bottom measurements 

(continuously logging both bathymetry and backscatter data; logging of water column data only 

on a few selected lines to keep the collected data volume manageable); 

- Completion of the suggested track pattern within the survey blocks by repeating more widely 

spaced sailing patterns (ideally 150 – 200 m spacing) and progressively filling in gaps in between, 

rather than sequentially surveying directly adjacent tracks in the aspired grids with narrow line 

spacing (40 to 60 m; Table 1); this has several advantages, like easier navigation, spreading of 

lower quality lines in case weather deteriorates, less switching of streamers etc. 

 - Block A and B have priority level 1; Block C has priority level 2; 



- Max. 1 m wave height limitation to be respected (to the extent possible), to ensure a decent 

acoustic/seismic data quality. 

(iii) Step 3: based on the data acquired in step 2, determine the location for a study area to execute an 

AUV pilot study in order to test the performance of the sub-bottom profiling and side scan sonar modules 

in the PEZ. The size of the study area and track pattern should be tuned to a few short AUV dives of 1-2 h, 

i.e. the typical duration of the windows with minimal tidal currents in the study area. To ensure the 

manoeuvrability of the AUV in the relatively strong tidal currents in the PEZ, sub-bottom profiling and side 

scan sonar are to be performed in separate dives so that the length of the vehicle can be minimised (using 

the configurations shown in Figures 3B and 3C respectively).  

(iv) Step 4: collect a few long acoustic/seismic lines across the PEZ and tie lines between the selected 

pseudo-3D grids, so that the measurements in the latter can be correlated between the blocks and linked 

to the wider, larger-scale stratigraphic and structural framework of the PEZ. Given the length of the lines, 

it is recommended to use the hull-mounted TOPAS PS18 on board RV Belgica in this step, since this system 

can be deployed at larger survey speeds (up to 6 kn). 

(v) Step 5: accommodate additional ad hoc measurements if the ongoing geological analysis of the data 

collected in steps 2 to 4 would indicate a need or added value for this, provided that the above steps have 

been fully completed and there is ship time remaining. 

 

2.3. Performed surveys and data collection 

To execute the above plan, 32 days of ship time (25 for RV Simon Stevin and 7 for RV Belgica) were 

requested and granted in 2023 and the first half of 2024. Table 2 provides an overview of the so far 

performed surveys and activities. As demonstrated in this table, all the activities that were planned 

(section 2.2) have been completed during these surveys; they are chronologically discussed in the 

following sections (2.3.1 to 2.3.8). 

Table 2. Overview of the performed surveys and activities in the context of the Clay Tectonics project. 

Survey Date Activity This report 

RV Simon Stevin 23-010 
(continuous) 

09/01/2023 – 13/01/2023 Cancelled due to bad weather  

RV Simon Stevin 23-120 
(continuous) 

06/02/2023 – 10/02/2023 - parameter tests 
- survey Block A 
- survey Block B 

- section 2.3.1 
- section 2.3.2 
- section 2.3.3 

RV Simon Stevin 23-300 
(continuous) 

03/04/2023 – 07/04/2023  - survey Block C - section 2.3.4 

RV Simon Stevin 23-600 
(day trips) 

31/07/2023 – 04/08/2023 Cancelled due to bad weather  

RV Belgica 23-23 
(continuous) 

20/11/2023 – 23/11/2023 - AUV pilot study 
- survey correlation lines 

- section 2.3.5 
- section 2.3.6 

RV Simon Stevin 24-270 
(continuous) 

13/05/2024 – 17/05/2024  - extra ad hoc survey Block D  
- extra ad hoc survey deep seismics 

- section 2.3.7 
- section 2.3.8 

 



2.3.1. Parameter tests 

Parameter tests were performed to establish optimal acquisition settings for the Innomar parametric SBP 

and the sparker seismic system, prior to executing the pseudo-3D surveys in Block A, B and C. These tests 

were performed in the PEZ, through repeated runs on line AI0800 in Block A (location indicated in 

Figure 1). 

For the Innomar parametric SBP measurements, the main variable is the secondary low frequency (SLF). 

Four SLFs were tested (4, 6, 8 and 10 kHz), demonstrating the loss in penetration and gain in vertical 

resolution as the SLF increases (Figure 5). For the objectives set in the Clay Tectonics project, a SLF of 6 kHz 

was considered to provide the best trade-off between penetration and resolution. The other selected SBP 

acquisition parameters are shown in Table 3. 

For the sparker seismic system, the variable with the biggest effect on the achieved penetration and 

resolution is the output energy. Output energies equal to 600 and 800 J were tested (in both cases using 

all 360 sparker tips), with the latter yielding a better penetration and more clearly defined sub-bottom 

reflectors, at the cost of a wider seafloor reflection (Figure 6). Considering that the signal (reflection) width 

can be improved in the processing (see section 3), the higher output energy of 800 J was selected. The 

other sparker acquisition settings are summarized in Table 3. 

Table 3. Overview of the most significant acquisition settings used for the Innomar parametric SBP and sparker 
seismic measurements in survey blocks A, B and C. The same settings were eventually used in block D as well, which 
was completed later in the project. 

Innomar parametric SBP Sparker seismic system 

Parameter Value Parameter Value 

Secondary low frequency 6 kHz Output energy 800 J 

Trace length 25 m Recording length 0.25 s 

Ping rate Auto-optimized Shot interval 0.5 s 

Gain 20 dB MC-streamer gain 6 dB 

 



 

Figure 5. Innomar parametric SBP profile AI0800 acquired with four different secondary low frequencies (from top to 
bottom: 4, 6, 8 and 10 kHz). Note the decrease in penetration as the SLF increases. The vertical scale is in milliseconds 
two-way travel time (twtt).



 

Figure 6. Raw sparker seismic profile AI0800 (as recorded in channel 5 of the SIG multi-channel streamer), acquired with two different output energies (top: 600 J; 
bottom: 800 J). The vertical scale is in milliseconds two-way travel time (twtt). 



2.3.2. Survey site 1 (Block A) 

In pseudo-3D survey site 1 (Block A), a grid with a total length of 164 km was completed. The Innomar 

parametric SBP, sparker and MBES measurements were executed as planned in section 2.2 (Figure 7), 

using the settings established in the parameter tests (Table 3). Aided by favourable weather conditions 

(waves continuously under 1 m height), all data are of good quality; a representative SBP and sparker 

example is shown in Figure 8. 

 

Figure 7. Maps showing the acquired SBP, sparker and MBES grids in pseudo-3D survey block A. 



 

Figure 8. Representative acoustic/seismic data examples from pseudo-3D block A. (A) Innomar SBP profile. (B) 
Sparker profile, as recorded with channel 5 of the SIG multi-channel streamer. The vertical scale is in milliseconds 
two-way travel time (twtt). 

2.3.3. Survey site 2 (Block B) 

In pseudo-3D survey site 2 (Block B), a grid with a total length of 309 km was completed. The Innomar 

parametric SBP, sparker and MBES measurements were executed as planned in section 2.2 (Figure 9), 

using the settings established in the parameter tests (Table 3). The data are of good quality, since the 

weather conditions were favourable (waves continuously under 1 m height). Representative SBP and 

sparker examples are shown in Figure 10. 



 

Figure 9. Maps showing the acquired SBP, sparker and MBES grids in pseudo-3D survey block B. 



 

Figure 10. Representative acoustic/seismic data examples from pseudo-3D block B. (A) Innomar SBP profile. (B) 
Sparker profile, as recorded with channel 5 of the SIG multi-channel streamer. The vertical scale is in milliseconds 
two-way travel time (twtt). 

2.3.4. Survey site 3 (Block C) 

In pseudo-3D survey site 3 (Block C), a grid with a total length of 290 km was completed. The Innomar 

parametric SBP, sparker and MBES measurements were executed as planned in section 2.2 (Figure 11), 

using the settings established in the parameter tests (Table 3). The data were acquired under favourable 

weather conditions (waves continuously under 1 m height) and are thus of good quality. Representative 

examples are shown in Figure 12. 



 

Figure 11. Maps showing the acquired SBP, sparker and MBES grids in pseudo-3D survey block C. 



 

Figure 12. Representative acoustic/seismic data examples from pseudo-3D block C. (A) Innomar SBP profile. (B) 
Sparker profile, as recorded with channel 5 of the SIG multi-channel streamer. The vertical scale is in milliseconds 
two-way travel time (twtt). 

2.3.5. AUV pilot study 

Two AUV-dives were planned to test the capabilities of the SSS and chirp (SBP) modules in imaging the 

seabed and substrate in the Princess Elisabeth Zone. A small (300 x 300 m) area within Block A, showing 

interesting bottom topographic features and small-scale subsurface fault splays, was selected for these 

tests. During the first dive (~40 min duration), the AUV covered a lawnmower grid (300 x 150 m) with the 

SSS module as primary payload (Figure 13). The resulting (unprocessed) mosaics yield a good image of the 

seabed, showing a dominantly flat seafloor with a few U- to V-shaped ribbons that likely reflect the 

presence of small sand accumulations like ripples (Figure 13). An expression of subsurface faults on the 

seabed (e.g. as lineaments) could not be observed. The second dive, aiming to test the chirp SBP module 

on the same location as the first dive, had to be cancelled due to adverse weather during the allocated 

tidal window. However, another SBP-dive could be performed further south (Figure 14), on a location with 

a similar water depth and substrate (i.e. Kortrijk Formation) as the originally planned location. This dive 

consisted of two lawnmower grids in perpendicular directions, in total covering a 300 x 250 m area with 



20 and 30 m line spacing for in- and cross-lines respectively. Between the two grids, the AUV came to the 

surface to receive a GNSS position fix. The resulting chirp SBP data show no bottom penetration. This can 

be most probably attributed to the fact that the sweep frequency (14 to 21 kHz) is too high. Alternative 

ways for automated/uncrewed sub-bottom surveying on very dense survey grids (e.g. with line spacings 

down to 5 m that are unachievable for a conventional ship like RV Simon Stevin) are therefore being 

considered. Integrating the Innomar parametric SBP onto VLIZ’ unmanned surface vehicle (USV) Gobelijn 

(Maritime Robotics Mariner X) currently seems to be the most viable option; this approach will be further 

explored in the coming months. 

 

Figure 13. Track and (unprocessed) mosaics completed by AUV Barabas during the side scan sonar test dive. 



 

Figure 14. Map showing the track of AUV Barabas during the chirp test dive. 

2.3.6. Survey correlation lines 

Long correlation profiles were acquired using the hull-mounted TOPAS parametric sub-bottom profiler 

onboard RV Belgica. The completed grid (with a total length of 240 km; Figure 15) has yielded several high-

quality tie lines, which allow to link the observations in the pseudo 3D-blocks to each other and to the 

wider stratigraphic framework of the PEZ. The grid was furthermore extended to the NW of the PEZ, in 

order to investigate the potential influence of pre-Ypresian structures (related to the so-called 

Noordhinder Deformation Zone3) on the formation of the CTFs. For the acquisition, a 2 kHz Ricker pulse, 

0.2 s shot interval, 110 ms recording length (with 5 ms delay) and 64 kHz sampling frequency were used. 

These settings were based on experience gained during earlier surveys with the TOPAS system in the 

southern North Sea and proved to be satisfactory; a representative example is shown in Figure 16.  

 
3 The Noordhinder Deformation Zone is a collection of structural anomalies (folds, faults) in the Meso-/Cenozoic 
cover, occurring in a NE-SW oriented, >75 km wide zone north of the Noordhinder sandbank. These features are 
hypothesized to be induced by the tectonic reactivation of older structures in the underlying Palaeozoic basement 
of the London-Brabant Massif (De Batist, 1989). 



 

Figure 15. Map showing the correlation lines acquired with the TOPAS PS18 system onboard RV Belgica. 

 

Figure 16. Example of a TOPAS SBP profile acquired in the PEZ with RV Belgica. The vertical scale is in milliseconds 
two-way travel time (twtt). 



2.3.7. Ad hoc survey site 4 (block D) 

The ongoing geological analysis of the data acquired in 2023 (as described in sections 2.3.1 – 2.3.6) 

revealed that an additional pseudo-3D block in between Blocks A and C could add significantly to the 

interpretation of the origin of CTFs in the PEZ. An additional dense grid (Block D) with a size of 2.5 x 1.5 

km and 50 m in- and crossline spacing (Figure 17) was therefore planned and completed in May 2024. 

These measurements adopted the same approach, methodology and acquisition settings as outlined for 

pseudo-3D blocks A, B and C (Table 3), with the exception that sparker data were only recorded with a 

dual-channel streamer. The resulting grid has a total length of 200 km, with all collected data (Innomar 

parametric SBP, sparker, MBES) showing a good quality (see representative examples in Figure 18).  

 

Figure 17. Maps showing the acquired SBP, sparker and MBES grids in pseudo-3D survey block D. 



 

Figure 18. Representative acoustic/seismic data examples from pseudo-3D block D. (A) Innomar SBP profile. (B) 
Sparker profile, as recorded with channel 5 of the SIG multi-channel streamer. The vertical scale is in milliseconds 
two-way travel time (twtt). 

2.3.8. Ad hoc survey deep seismic lines 

The first analyses of the correlation grid sailed with the TOPAS parametric SBP (section 2.3.6) 

demonstrated that large-scale structural deformations (faults, folds) in the deposits underlying the 

Kortrijk Formation could have an influence on the expression of CTFs in the PEZ. It was therefore deemed 

useful to try to collect sparker seismic profiles aimed at maximal penetration, to test whether these 

deformations in the pre-Ypresian (Palaeocene, Cretaceous and Palaeozoic?) strata can indeed be 

adequately imaged. These tests were performed over a large-scale grid (Figure 19), similar to the one 

completed for the TOPAS correlation lines (Figure 15). In total, 160 km of sparker profiles were acquired, 

using the GSO360 sparker source tuned to a high output energy (1750 J) and shot rate of 1 s. The data 

were recorded with VLIZ’ 24-channel streamer, with a recording length of 0.7 s. The resulting data show 

a good quality and penetration (see representative example in Figure 20), but further processing will be 

needed to elucidate to which extent they capture the targeted deeper geological structures.  



 

Figure 19. Map showing the seismic lines aimed at deep penetration, acquired with the sparker seismic system during 
RV Simon Stevin survey 24-270. 

 

Figure 20. Representative example of a sparker profile with large recording length (recorded with channel 5 of the 
SIG multi-channel streamer), aimed at imaging deeper geological structures in the wider PEZ region. The vertical 
scale is in milliseconds two-way travel time (twtt).  



3. Processing of seismic and acoustic data 

While the overall quality of the incoming geophysical data and accuracy of the linked positioning 

information were continuously monitored during acquisition at sea, the major part of the processing was 

performed onshore after the surveys. The overall aim of the processing is (i) to ensure that all data are (as 

precisely as possible) located in the correct geographical position (this includes navigation processing, 

motion corrections, offset corrections, tidal corrections) and (ii) to optimize the signal-to-noise ratio, with 

a particular focus on highlighting the expression of CTF’s in the geophysical data. 

Since the Clay Tectonics project focuses on the sub-bottom detection and characterization of CTF’s, this 

section will only describe the processing of the sparker seismic profiling data (section 3.1) and the 

parametric sub-bottom profiling data (section 3.2).  

3.1. Sparker seismic data 

3.1.1. Multi-channel sparker data 

Multi-channel sparker seismic data were recorded using a Delph analogue acquisition unit in combination 

with Delph acquisition software. This set-up synchronizes the emission of the seismic signal by the sparker 

source, the recording of the reflected signal by the hydrophones in the streamer, and the registration of 

the ship’s position through the input of a GNSS system. The result is a raw seg-y file (one per profile), 

which is further processed using RadExPro software. The used processing workflow is summarized in 

Figure 21.  

The raw seg-y data is first loaded and converted into the RadExPro internal processing format, after which 

shot, receiver and common depth point coordinates (in UTM) are defined based on the ship’s navigation 

(recorded in the data headers) and the known layback and geometry of the source and streamer. It should 

be noted that a positioning uncertainty of a few meters exists in this procedure, since the source and 

streamer lay-out might occasionally deviate from the assumed straight line behind the vessel due to 

currents, waves etc. A first pre-processing flow, including top mute, bandpass filter, spherical divergence 

correction, F-K filter, burst noise removal and time-frequency domain (TFD) noise attenuation modules, 

is run to remove coherent and incoherent noise from the data.  

Next, two types of multiple4 elimination methods, surface related multiple elimination (SRME) and zero-

offset demultiple, are applied using a temporary (constant) velocity profile. The thus filtered data are then 

stacked (i.e. traces that belong to a common depth point are corrected for normal move-out and summed, 

which improves the signal-to-noise ratio), based on a more detailed velocity model established using the 

‘Interactive Velocity Analysis’ module. A first post-stack processing flow consists of deghosting, an 

additional multiple elimination procedure based on predictive deconvolution (using the seafloor pick as 

prediction gap), F-X predictive filtering and TFD noise attenuation, in order to further suppress noise and 

remaining (short-path) multiple energy in the stacked profile. Kirchhoff (time) migration is then applied 

to move reflections to their correct position. Finally, a last post-stack processing flow (with automatic gain 

correction and top muting), tidal correction and seg-y output are performed, which results in a processed 

seg-y file that is ready for importing in the interpretation software (i.e. Kingdom – S&P Global). A 

 
4 Multiples are unwanted (noise) reflections that originate from travel paths along which the emitted 
seismic/acoustic signal incurs more than one reflection. These extra, repeated reflections occur predominantly at 
the air-water interface, but can also happen between sediment interfaces in the subsurface (giving rise to so-called 
‘interbed multiples’) (Dondurur, 2018).  



comparison of a brute stack (i.e. stacked profile without pre-stack filtering, multiple elimination, post-

stack processing and migration) and a fully processed, stacked profile (according to the flow shown in 

Figure 21) is shown in Figure 22. 

Appendix A provides a more detailed, step-by-step description of the above described processing flow, 

including all used RadExPro module settings and parameter values. It is finally noted that, with the 

exception of the first (data loading) and last (seg-y output) steps in the flow which can be ran in batch 

mode (i.e. for all profiles at once), the processing is executed profile per profile. This approach is required 

to ensure that adequate seafloor picking, velocity analysis and quality checks can be performed for each 

profile individually. 

 

Figure 21. Processing diagram for multi-channel sparker seismic data. 



 

Figure 22. Top: stacked sparker seismic profile without applying pre-stack noise filtering, multiple elimination, post-
stack processing and migration (i.e. the so-called brute stack). Bottom: fully processed, stacked profile, following the 
scheme shown in Figure 21. In the fully processed profile, multiples are suppressed and primary reflectors overall 
show a better lateral coherence and sharper vertical expression (i.e. better vertical resolution). 



3.1.2. Dual-channel sparker data 

The acquisition and processing of sparker seismic data using a dual-channel streamer is largely similar to 

the procedure described in the above section for the multi-channel streamer. Channel 1 of the used SIG 

dual-channel streamer is mainly intended for use in very shallow water depths (< 15 m) and is therefore 

not considered here. As such, the recorded data in channel 2 of the streamer can be treated as single-

channel reflection seismic profiles, for which the adopted workflow in the processing software (RadExPro) 

is provided in Figure 23. This workflow follows the same scheme as used for the multi-channel sparker 

profiles (see Figure 21), with the exception that velocity analysis and stacking are not applicable to single-

channel reflection seismic data. In the processing modules where velocity input is required (multiple 

elimination and Kirchhoff time migration), a single velocity model per survey block was assumed, based 

on the detailed velocity analysis performed during the multi-channel processing.  

 

Figure 23. Processing diagram for dual-channel sparker seismic data. 



3.2. Parametric sub-bottom profiler data 

The adopted workflow for the processing of parametric SBP data is schematically shown in Figure 24. 

During the acquisition of Innomar Quattro and TOPAS parametric sub-bottom profiling data, the reflected 

acoustic signal and the position/motion of the vessel are simultaneously recorded, respectively using the 

SESWIN and TOPAS 3.3 acquisition software. This yields raw data files in .ses3 format (for the Innomar 

Quattro SBP) or seg-y (.sgy) format (for the TOPAS SBP). In the former case, a conversion to .raw format 

and then .sgy is still needed, along with motion and navigation processing (lat/lon to UTM conversion, 

offset corrections using imported heading values, coordinate interpolation) using the ISE software (Figure 

24). In the latter case, these steps are directly applied online and thus already accounted for in the raw 

seg-y file. Since the position of the sub-bottom profilers relative to the GNSS antennas is fixed and 

precisely known, the positioning accuracy of the acquired SBP data is usually less than 1 m and therefore 

significantly better than for the sparker data (see section 3.1.1). 

In the next phase, the seg-y files (both Innomar Quattro and TOPAS) are further processed using the 

RadExPro software (Figure 24). All lines are processed collectively using the 'Batch Mode' function, which 

saves time by avoiding the need to process each line individually. The first three steps are applied to 

prepare the data for the main processing: firstly, the data is converted from seg-y to the RadExPro inner 

processing format using the 'SEG-Y Input' and 'Trace Output' modules; then, a navigation quality check is 

performed to verify and correct potential remaining navigation outliers; thirdly, tidal heights (derived 

from tidal stations or GNSS measurements in case a stable RTK correction was available during acquisition) 

are matched and imported to the data headers using the time stamp. In the next step, high-amplitude 

noise spikes/bursts are attenuated using the ‘Burst Noise Removal’ module. Subsequently, 2D spatial 

filtering is applied to remove additional noise and improve the reflection coherency, whereas the module 

‘Amplitude Correction’ is used to correct for spherical divergence. The effects of the burst noise removal, 

2D spatial filtering and amplitude correction steps are demonstrated in Figure 25. In the tide correction 

step, the imported tidal height is subtracted from the data in order to reference all profiles to the same 

level (LAT). Finally, the thus processed datasets are exported as seg-y files using the ‘SEG-Y Output’ 

module, so they can be imported in any interpretation software.  

A more detailed, step-by-step overview of the applied parametric SBP processing, including the used 

module settings and parameter values, is provided in Appendix B. 



 

Figure 24. Parametric SBP processing diagram. 



  

  

Figure 25. Example of the processing of an Innomar parametric SBP section in RadExPro, demonstrating the effect of 
the different processing modules: (a) raw SBP profile; (b) SBP section after applying burst noise removal; (c) SBP 
section after applying burst noise removal + amplitude correction; (d) SBP section after applying burst noise removal 
+ 2D spatial filtering + amplitude correction. 

  

a b 

c d 



4. Conclusions 

The current deliverable outlines the tailormade geophysical data acquisition and processing strategy for 

the detection and characterisation of clay tectonic deformations in the Princess Elisabeth Zone.  

A survey plan was elaborated based on the instrumentation available within the consortium and the 

granted ship time. Aided by favourable weather conditions, the surveys could be performed according to 

plan, resulting in > 1,300 km of good-quality 2D seismic/acoustic profiles. These data are clustered in four 

carefully selected dense grids aimed at generating pseudo-3D reconstructions, and two large-scale grids 

(spanning the entire PEZ) intended to facilitate correlations between the pseudo-3D blocks and 

extrapolations to the wider regional stratigraphic and structural framework. Furthermore, a first pilot 

study with sub-bottom profiling and side scan sonar modules mounted on an AUV was completed.  

Post-survey data processing workflows were developed and tailored to the specific characteristics of the 

obtained SBP and sparker acoustic/seismic data, and have proven to be highly effective in optimizing the 

visualisation of subsurface CTFs in the PEZ.  

The result of the work described in this deliverable is an extensive geophysical dataset that can be 

considered largely sufficient (both in terms of quantity and quality) for pursuing the aims regarding the 

characterization and geological interpretation/analysis of CTFs in the PEZ (tackled in work package 2 of 

the Clay Tectonics project) and, following from that, the overall research questions addressed in the Clay 

Tectonics project.  
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Appendix A. Detailed workflow for the processing of multi-channel sparker reflection seismic data 

  



1 – DATA LOAD & HEADER DEFINITIONS 

Firstly, raw SEG-Y format data needs to be imported and converted into the RadExPro internal format for 

processing. 

 

SEG-Y Input module is used for seg-y data reading: 

1 – File > Choose the raw SEGY file 

2 – When you choose the raw data file, the fields are automatically filled in as below (note: VLIZ 

Sparker data has a ‘Sample interval’ of 0.125 and ‘Trace length’ (number of samples per trace) of 

2000, so the record length = 0.125 x 2000 = 250 ms). 

 

 

 

Trace Output converts SEG-Y raw data into RadExPro internal format. 

 

  



Before continuing, some headers are also (re)defined for clarity and further use in the processing 

workflow: 

* Other/new headers to (re)define: 
    Note: Before inserting a new header to database header, all data display windows should be closed! 

 
Go to Database > Header Fields List > Edit 

Edit headers fields... window click Add (Ins)  
 

 

 

Give a name, type, and description (not mandatory). 

 

 

 

 

 

 



Table A1. Outline of headers added into the RadExPro project manager. 

HEADER NAME TYPE DESCRIBTION 

SFLR_PICK Real  

RMS_SIG Real  

RMS_WATER Real  

RMS_DEEP Real  

RMS_SFLR_ABOVE Real  

PICK3 Real  

PICK4 Real  

WB_TIME Real  

MODEL Int32  

SRME_GEOM Real  

MULT_W1 Real  

MULT_W2 Real  

MULT_W3 Real  

MULT_W4 Real  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2 – RAW DATA QC 

As a first quality check, raw data is quickly displayed in CHANNEL:FFID order. Channel 1 and 15 can be 
chosen to verify the correct functioning of the first and second part of the streamer connection. 
   

 

 

‘Data sets’; Input data which you want to show. 
 
‘Sort Fields’; Sort data according to header information. First FFID, second CHAN: this means sorting data 
up to FFID first and then sort the channels under each FFID. We use CHAN:FFID order.  
 
‘Selection’; 1,15:*  (channel 1 with all shots and channel 15 with all shots) 

Result 

 
        Figure A.01. 15. channel display from line BX2500 



3 – MARINE GEOMETRY INPUT AND COORDINATE TRANSFORMATION 

3.1 First option (without Python script) 

3.1.1 Header Output 

The ship track coordinates are used for calculation of CDP locations according to the source and streamer 

offsets to the GNSS antenna. Recorded GNSS coordinates value are in decimal seconds, and a conversion 

to UTM (metric system) is done for use in Kingdom or other interpretation software. The SOU_X 

(longitude) and SOU_Y (latitude) headers contain the vessel track location by default.  

SOU_X and SOU_Y headers are exported with their corresponding FFID headers using the below flow. In 

the Trace input module, ‘Selection’: all shots in the first channel are enough to export all navigation data. 

Add Headers to ‘Export Fields’, choose ‘Export all traces’ and select the save location. 

 

 

 

 



3.1.2 Marine Geometry Input 

Using the GNSS antenna locations and offset values of source and streamer, CDP points are calculated and 

transferred to the CDP_X and CDP_Y headers automatically. We use the Marine Geometry Input* 

(standalone) module.  Select ‘Show ship navigation file layout…’ to customize columns and select the 

coordinate system. 

 

 

• ‘File name’ shows the exported ship coordinate file (see previous step). This file has coordinates 

in decimal seconds, so the columns need to be defined accordingly. 

• Change the ‘Matching field’ column value to 1 (FFID), ‘Ship GPS[LAT-Sec]’: 3 (SOU_X), ‘Ship 

GPS[LON-Sec]’: 2 (SOU_Y). Column value = -1 means that this field is not used in the data import.  

• ‘Lines’ from 2 to 0 means start from row 2 to all.  

• ‘Coordinate system’ is lat/long - UTM zone 31 



 

‘Source/streamer geometry’ (as measured on the ship during acquisition) is defined in the second tab: 

 

 

 

 

 

 



3.2 Second option (with Python Script) 

3.2.1 Install Python and libraries. 

First you need to install the last version of Python on to the suggested default location on your computer. 

Be sure to add a path global variable in the installation window. Check the Add Python to Path box. 

 

After Installation, open cmd as administrator, type the path of the installation folder and click ‘Enter’ like 

below and install some packets with pip command. 

 

• pip install pyproj  

• pip install numpy 

• pip install matplotlib 

• pip install mplcursors 

 

3.2.2 Python Proxy 

To convert coordinates from decimal seconds to UTM, raw data should be selected as input sorted as 

FFID:CHAN (*:*), then put or write the python script as written below in Python Proxy module and add 

output again as raw data. If you wish, you can change the output name. 

 

 



Note that If you work another UTM Zone, in the python script under the DEFINE ZONE  +zone=31 and 

+north must be changed up to project your project area. 

 

The seismic line starting point is shown with a red dot, the blue line represents the converted seismic line 

(ship’s GNSS) in UTM format. 

 



3.2.3 Marine Geometry Input 

Select ‘Take Coordinates from Headers…’ and choose SOU_X and SOU_Y for X and Y header selection, 

respectively.  In ‘Source/streamer geometry’ tab are filled in as shown in the first option. Then execute 

Marine Geometry Input*. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



4 – SHOT DOMAIN SEAFLOOR PICKING 

4.1 First option: automatic picking in common-channel gathers 

Seafloor picking is of great importance to remove direct waves and other water column noise from data 

in the beginning of processing. This improves the functioning of the next modules applied in the flow that 

focus on the elimination of noise in the sub-bottom part of the seismic profile.  

 

Trace Input data should be ordered as CHAN:FFID (select all) as it is easier to pick the reflection along 

continuous common-channel gather.   

 

Bandpass filtering and Amplitude Correction modules remove unwanted very low and very high 

frequencies and allow trace equalization in the seismic data to boost sea floor reflections, respectively.  

  

 

 

 

 

 

 

 



NMO/NMI introduces the normal moveout correction, ‘Single velocity function’ is set to 0-250:1.55 (time 

(ms): velocity (m/ms)) for all traces  

 

 

 

 

 

 

 

 

2D Spatial Filtering smooths the data slightly along the trace axis (with a 3-point filter). The 2-D Mean 
algorithm averages the samples within the bounds of the filter application window: 
 
‘Number of traces’; number of traces to be used as the width of the operator of the two-dimensional 
spatial filter. This value must be an odd integer.  
‘Number of samples’: number of samples to be used as height of the operator of the two-dimensional 
spatial filter. This value must be an odd integer.  
‘Filter mode’; Normal - allows replacing of the initial value in the center of the two-dimensional filter 
operator by the calculated value.  
 
 
 
 

 

 

 

 

 

 

It is needed to give a starting depth for the calculation of the seafloor reflection, so PICK1 header is 

assigned as 40 ms in our data via the Trace Header Math module (this can be changed according to the 

data contents). 

 

 



The First Breaks Picking module picks the first amplitude specified by the ‘Threshold’ in the 60 ms window 

starting from PICK1 (which was previously set to 40 ms in Trace Header Math) and saves the 

corresponding time to the SFLR_PICK header.  

 

 

The Header Averager module averages SFLR_PICK header values in traces that appear in the flow. 

Averaging is performed in a sliding window of the given length. As a result of the module operation the 

raw header values are rewritten. 

 

 

Next, the Trace Header Math module shifts the SFLR_PICK slightly to the top (to make sure it is located at 

the start of the wavelet). 

 

 

 

 



The Trace Header NMO/NMI introduces inverse moveout correction to the SFLR_PICK header with the 

same water velocity which was used previously. This finalizes the picking. 

 

 

 

 

 

 

 

 

 

The SFLR_PICK header containing the picked travel times is then saved to the raw dataset with the Header 

<-> Dataset Transfer module using the headers CHAN and FFID for matching. 

 

 

Result 

 
Figure A.02. Quality check of the automated seafloor picking workflow in the shot gathers (note that   the 
automated picking is performed on common-channel gathers, as described above). 



4.2 Second option: manual seafloor picking 

 

First, the input raw data (ordered as FFID:CHAN for every 20 shots with all channels; 1-9999(20) : *) are 

displayed through screen display. 

 

Then go to ‘Tools’ in the main tool bar; select Pick > New Pick 

 

 

 

 

 

 



Pick above the seafloor like shown below: 

 

Go to, Tools > Pick > Project 

 

With this procedure, the program propagates picks to all shot gather. You must check picks which may 

cross the seafloor. In this case, press left shift + right mouse on the seafloor picks to raise all of them at 

once, till you are sure that none of the picks cross the seafloor directly. An example is given below. 

 



 
Figure A.03. Before shifting the picks, which cross the seafloor (top) and after shifting the picks up 
(bottom). 

 

To save; follow Tools > Pick > Save pick as.  Enter an object name and choose pick headers as FFID:CHAN, 

like shown in the below ‘Save pick to’ window. 

  

 

 

 

 

 

 

 

 

Then arrange the input selection for all shots and all channels (*:*) in the Trace Input module and display 

again. 

 



Go to Tools > Picks > Load picks w/interpolation and choose the saved picks (named ‘seafloor’). 

 

 

 

 

 

 

 

 

 

 

All picks will be propagated to all shots. 

 

 

 

 

 

 

 

 

 

Go to Tools > Picks > Save to header(dataset) 

 



‘Header Field’; select the desired Header to save the picks in (SFLR_PICK), ‘Reflect changes in’; select the 

dataset you want to save this header to (raw data), ‘Pick Headers’; select FFID:CHAN order. 

 

 

4.2.1 QC of seafloor picking  

 

Sort the data as FFID:CHAN, select the FFID:CHAN as 1-9999(5):* and display with the ‘Plot headers..’ . 

Select the parameters as shown below for the SFLR_PICK header view. 

  

 

 

 

 

 

 



Result 

 
Figure A.04. Manual seafloor picking QC view (SFLR_PICK). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



5 – DATA PREPROCESSING AND CDP SORTING 

5.1 Data preprocessing 

 

Note: It's important to test the data to see how we can optimize the variables in each module. Then we 

can compare the results. Compare the results. It is advised to perform these tests on a selection of shots 

before applying the flow to all shots.  

Trace Input for FFID:CHAN and *:* (all) selection 

 

 
Trace header math is used for defining the top mute boundary to remove unwanted direct waves and 

interferences in the water column, so that other modules can work more effectively on the data. The 

header WB_TIME is therefore defined as a 3 ms upward shift of the SFLR_PICK (to prevent any data loss 

from the seafloor).  

Trace Editing module uses the WB_TIME header as the boundary for top muting. 

 



 

Bandpass Filtering is applied using the ‘Ormsby type’ filter which is described by four frequency points on 

the frequency-amplitude spectrum. Our sparker source has a range between 0 to 4000 Hz. However, the 

0-100 Hz range includes swell noises and very low frequency noise which should be disregarded from the 

emitted source spectrum. As such, a low cut frequency of 100 Hz, low cut ramp frequency of 150 Hz, high 

cut ramp frequency of 2500 Hz and high cut frequency of 3500 Hz are applied. A tapering value of 10 

percent is used (note that the tapering value should be tested for example for values of 10, 30, 60, 90).  

 

Spherical divergence correction applies a time-variant gain function to the traces. Every sample of each 

trace is multiplied by the gain function, which compensates for the amplitude decay due to wavefront 

spherical divergence. The gain function is defined by two parameters: the ‘velocity function’, set to 0-

250:1.55 (time1-time2: velocity) and the ‘normalization’ (constant time).  

 



F-K Filter eliminates coherent linear noise and aliasing reflected energy. The signal is transformed from 

the time-distance (t-x) domain to the frequency-wavenumber (F-k) domain by applying a mathematical 

transformation to the traces, and then converting the results back to the (t-x) domain. 

Firstly, The F-K window should be defined in the shot domain. Trace Input is adjusted for every 20 shots 

with all channels, with all above mentioned modules applied for the screen display. Select the F-K window 

analysis button and draw a rectangle including all channels of a shot until the end of the record time (red 

rectangle); then the pop-up F-K filter window appears. 

 

  

 

 



F-K analysis window parameters are defined as follows:  

‘First and second header’; OFFSET – ‘Manual DX’; group interval value (2 m).  

If you want to pass the data inside the drawing polygon, the ‘Filter mode’ should be ‘Pass’.  

Gain sliders can be used to increase/decrease the color intensity in the TX and FK view, respectively. 

 

 

To draw a polygon, click the  button and mark the corners with the left mouse; if you want to change 

the point location, drag and drop point with the right mouse button; to delete a point, double click on the 

point with the right mouse button. To delete polygon completely, click the  button. 

 



To see the FK filtering result on the data, click Preview; to get back click Undo. If you draw a new polygon 

or change the polygon edges and you want to view the new results, it is needed to first click Undo to re-

display the raw data view first.  

 

Different polygons can be drawn on the same data. After the first polygon, go to Pick > New Polygon. If 

you want to adjust one of the polygons, you need to activate it from Pick > Activate polygon.  

 



The   button is used to translate a slope in the t-x domain to a slope in the F-K domain. 

 

Then save the adequate polygons to use in the F-K filter module, by going to Pick > Save all polygons > 

choose save location and enter a name.  

 

 

 

The F-K filter module is then added to the main flow. Choose the saved polygon under Polygons; the 

‘distance between traces’ and ‘operation mode’ must be the same as used in the F-K analysis window. 

Other parameters should be tested as a function of the data. A Taper window width of 20 % gives a good 

result. 



 

 

Figure A.05. Shot gathers without FK filter (left side) and with FK filter (right side). After removing aliasing 

from the data, noise-like reflections can appear on the seafloor, but these do not affect the sub-bottom 

data. Overall, after the F-K filter, the data has a cleaner view. 

 

 



Burst Noise Removal is designed for the removal of high-amplitude noise bursts from the seismic traces. 

‘Window size for average value calculation (traces)’; number of traces in the sliding window used for 

average calculation.  

‘Rejection percentage (%)’; This percentage of the highest and lowest amplitudes will be rejected; the 

remaining will be averaged.  

‘Do not change amplitudes lower than (%) of the average’; When the average over the window is below 

this threshold, this sample is skipped and remains unchanged.  

‘Modify values when exceed average in more than N times’; When the absolute amplitude of the sample 

at the middle trace is N-times higher than the average for this sample over the windows, it is substituted 

by the average.  

 

 

Figure A.06. Shot gathers without Burst Noise Removal (left side) and with Burst Noise Removal (right 

side). 

 



TFD Noise Attenuation is designed for attenuation of noise localized in the frequency domain and in the 

time domain as well. It allows to remove local narrow frequency band noises without affecting the 

spectrum of the remaining record.  

 

 

 

 

Figure A.07. Data without TFD Noise Attenuation (left side) and with TFD Noise Attenuation (right side) in 

single channel view. Scatter noise is reduced significantly. 



5.2 CDP sorting 

Sort data in CDP: OFFSET order in the Trace Input module, so the data can be processed in the CDP domain 

in the next processing steps. The input dataset is the preprocessed dataset as described in the above 

section. Trace Output is named 2-sort. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



6 – CDP DOMAIN SEAFLOOR PICKING 

For the next steps (such as SRME, predictive deconvolution) it is required to have a precise seafloor pick 

in the CDP domain.  

NMO introduces a constant normal velocity moveout correction (idem as in the shot domain seafloor 

picking), then the Ensemble Stack module stacks all traces within each ensemble of the flow into one 

trace. 

 

 

If the seabed is almost flat, Trace Editing can be used with the Specify Text option in the ‘Horizon’ field, 

to remove direct waves and some unwanted water column noise. Trace Header Math assigns the value 

of the PICK1 header to 40 ms (this value should be close to, but shallower than the shallowest seafloor 

depth in the data). 

 

 



 

 

With the above flow, a temporary/preparatory seafloor pick is stored in the header MARKER. After this, 

First Breaks Picking is applied again, using the MARKER header as a lead. Amplitude correction is also 

applied to add gain to the bottom reflections.  

 

MARKER header should be shifted up a bit to avoid cutting off the seafloor. 

 

 



Fill in the First Breaks Picking module parameters as shown below. Note that the ‘threshold’ value may 

need to be changed in function of the seismic amplitude in the data. The Header Averager module is 

inserted to eliminate remaining outliers in the seafloor picking. ‘Window length’ and ‘Alpha’ parameters 

are experimental values based on the data. The Header Dataset Transfer module writes the resulting 

FBPICK values (assign field) to the dataset using the CDP number as matching fields. 

 

 

 

 

Result 

 

Figure A.08. The result of automatic CDP picking. Pink horizon is MARKER header which shifted up 3 ms to 

calculate FBPICK, yellow horizon is FBPICK header which is true picking.  

 



7 – SRME (SURFACE RELATED MULTIPLE ELIMINATION) 

 

Before starting SRME flow, make sure the SRME_GEOM: Real (type) header has been added into the 

header database (see chapter 1). The data must be sorted as CDP: OFFSET.  

 

 

Note: SRME will not produce a correct output model if the data has direct arrivals! Therefore, direct 

waves must be muted from data at once. FBPICK is shifted 5 ms upward, then Trace editing module is 

applied to mute. 

 

 

 

 

 



2D SRME Interpolation is used for the interpolation of data onto a regular grid; parameters are filled in 

as shown below. The ‘Bin size’ and ‘source and receiver step’ are the CDP interval length (1 m). ‘Max. 

output offset(m)’ and ‘Symmetric part length(m)’ are the maximal offset number (for our data: 59 m). 

 

 

After interpolation, it is needed to apply kinematic corrections to the interpolated traces. In the 

NMO/NMI module, choose ‘Partial NMO’, then select ‘Header with desired non-zero offset’ parameter as 

N_OFF (this is the original offset, regular offsets are stored in the OFFSET header). ‘Single velocity function’ 

is filled with 0:1.55 under ‘velocity’ tab. 

 

 

2D SRME Prediction module predicts the multiple wave field based on a regular observation grid. It is 

recommended to set a value smaller than or equal to the Symmetric part length parameter in the 

prediction module. ‘Apply shaping filter’ is used to restore the original pulse waveform. If ‘Skip virtual 

traces’ is selected, the module will output only those traces that are required for restoration of the original 

data. 



 

The predicted multiple wave field must be reverted to the original dataset geometry with 2D SRME 

Geometry Return by selecting the same dataset and reference header. Then the second NMO/NMI 

module turns real offsets back using the same configuration as shown in the first NMO/NMI module. 

 

 

 

The header MODEL (int32) is used in the Wave Field Subtraction module (see next steps) to get rid of the 

multiples calculated by the SRME and Zero Offset Demultiple flows. The MODULE header is added to the 

data set before the SRME output. The value of MODEL is set to 1 in the Trace Header Math module. Finally 

Trace Output module is used to output the SRME model. 

 



Result  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure A.09.  CDP collection (left) and SRME output (right). SRME is the output of modeling multiples. 



8 – ZERO OFFSET DEMULTIPLE 

Zero-Offset demultiple module is designed for the suppression of multiples in data acquired at (near-

)zero offsets. The algorithm is based on adaptive subtraction of a model of multiples derived from the 

original wave field.  

 

The data is sorted as CDP:OFFSET.  

 

The NMO/NMI module is added for normal moveout correction with constant velocity 0:1.55 

 

The Zero-Offset DeMultiple model is obtained from the data itself by a static shift of the original traces. 

This static shift is equal to the arrival time of the seafloor reflection (FBPICK). The model can then be 

adaptively subtracted directly inside the Zero-Offset DeMultiple module or can exported to a dataset for 

applying the adaptive subtraction later using the Wave Field Subtraction module. Here, the latter option 

is used, by selecting the ‘Don’t subtract, output model’ option (this option outputs the shifted traces into 

the flow without subtraction). 



 

Next, the traces are multiplied by -1 using Trace Math to account for the negative sign of the sea surface 

reflection coefficient. The previously applied NMO/NMI is also reversed NMO selecting ‘NMI’ option. 

 

 



Finally, Trace Header Math is used to assign a MODEL number to this model. This number is later used in 

the wavefield subtraction for sorting input data. The model is saved to the dataset 3-ZOD-model. 

 

Result 

 

 
Figure A.10.  Input CDP gathers (top) and the corresponding model of predicted multiples by the Zero 
Offset Demultiple module (bottom) 

 

 



9 – WAVE FIELD SUBTRACTION 

Wave field subtraction (or adaptive subtraction) is a technique used in signal processing and data analysis 

to remove unwanted components (such as noise or interference) from a primary signal, using an adaptive 

algorithm. This method can effectively separate unwanted elements, even in a continuously changing 

environment or signal. 

 

 

Datasets for Trace Input are 2-Sort (i.e. the primary wavefield), 3-SRME-model (i.e. the multiple model 

generated by SRME) and 3-ZOD-model (i.e. the multiple model generated by zero-offset demultiple). ‘Sort 

Fields’ is using the CHAN:FFID:MODEL order. The ‘selection’ is *:*:* (all). It is not compulsory to input the 

SRME and ZOD models together (so using either only SRME or ZOD outputs to eliminate multiples). 

 

 

The following Trace Header Math module sets the headers used in the windows for multiple subtraction. 

MULT_W1, MULT_W2, MULT_W3, MULT_W4 should be added to the header list as Real format before 

applying the flow (see chapter 1). MULT_W1 represents the first seafloor multiple horizon. MULT_W2 and 

MULT_W3 are downward shifted copies of MULT_W1. MULT_W4 is the second seafloor multiple. All 

MULTI_W* headers and multiple locations are shown in the below figure. 

 



 
                     Figure A.11. MULTI_W* horizons and multiples. 

 

Wave Field Subtraction: ‘Number of models’ = 2 (in case of using only the SRME or ZOD model for input, 

this number should be 1). Four boundaries for processing windows are entered which were defined above 

with Trace Header Math. ‘Multiplication’ parameters stay as default. ‘Window usage’ for ‘window [1]’ is 

set to No (this is the window from time 0 to MULT_W1). ‘Windows [2], [3], [4] and [5]’ all have the same 

parameters, with the exception that in ‘window [2]’ the ‘maximum shift’ is limited to 10. The ‘Subtraction 

parameters’ and ‘usage of adjacent traces’ parameters were applied as shown below. ‘Process by 

ensembles’ is set to Yes and ‘Number of threads’ is set to 4 for faster computation. Finally, the Trace 

Output module saves the data. 
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Results:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
Figure A.12. Comparing the output views of one channel (number 12) to which no multiple 
suppression, only SRME, only ZOD, and SRME+ZOD were respectively applied 



10 – VELOCITY ANALYSIS 

Velocity analysis is of crucial importance to reveal geological substrata and structures. It comprises four 

phases. Each phase is applied sequentially.  

 

Phase 1: QC of the super gathers shows the quality of the velocity semblance and the quality of the 

reflections as well. The Super Gather module creates a collection of gathers, defined by CDP Start, CDP 

End, Step and Range. The module needs the maximal CDP value in the data (this can controlled by using 

the Database Navigator: double click on 2-Sort Output, select CDP column, go to Tools and select Show 

Statistics). 

 

 

Following Super gather, Bandpass and AGC modules are added to improve the visualisation of the 

computed velocity semblance.  

   



The Interactive Velocity Analysis (IVA) module prepares the input and output velocity files and the 

analysis window settings. The output and input velocity files should be the same if you are working with 

velocity files for the first time. You can select another input velocity if you have a compatible one in your 

database. After running this module, the velocity analysis window will appear, super gather CDPs (SCDP) 

can be controlled and the window can be exited without saving. Note: If you wish, you can start picking 

velocities directly from this velocity analysis window and skip to phases 2 and 3. The disadvantage of this 

method is that the IVA will be calculating semblance each time you switch from one super gather to 

another – when the super-gathers are large, this can be time consuming and annoying. 

 

 

 

Phase 2: The Velocity Analysis Precompute (VAP) module is used to pre-compute all super-gathers at 

once and then use the Interactive Velocity Analysis module as a stand-alone module that takes the pre-

computed semblances as an input. This makes navigation through the super gathers much faster. Super 

Gather, AGC and Bandpass Filtering modules are the same as above. Fill in the ‘Start velocity’ and ‘End 



velocity’, ‘Velocity step’, and ‘Time step’ parameters to adjust the semblance window (as determined in 

step 1). Enter ‘VAP result’ file a name. Then execute the flow (this might take some time). 

 

 

 

Phase 3: the Interactive Velocity Analysis stand alone module can now be run after setting some 

parameters. On the Semblance tab switch on the ‘Use precompute data’ tick-box and select the database 

object with the semblances created in step 2. In the ‘Output velocity’ tab, enter a name for the velocity 

file. 

 

 

 

 



In the ‘Input Velocity’ tab there are two options: selecting the velocity file given as output velocity, or 

selecting an existing velocity file. In the latter case, all velocity picks in the existing file will be pasted into 

the output velocity file. In the ‘Guide velocity’ tab select an existing velocity file to guide new velocity picks 

if desired (this is not mandatory and can remain empty). 

 

The ‘Semblance’, ‘Gather’, ‘STCK’ and ‘CVS Display’ tabs are used to set up the displays in the velocity 

analysis view. These can be left as default or can be adjusted during the velocity analysis. Then run the 

module to start the velocity picking. A single click with the left mouse button places the velocity pick. A 

double-click with the right mouse button on the pick will remove it. Holding the right mouse button down 

on the pick will drag and drop the pick to the desired position in the semblance window. When you have 

finished picking an SCDP, use the arrows to go to the next or previous SCDP. The SCDP you want to go to 

can also directly be selected from the drop-down panel at the top right. Finally click ‘Save’ (saving after 

each SCDP is a good idea in case the software crashes during the velocity picking). 

 

Semblance Gather STCK CVS 



Tool Bars  tab is for adjusting the visualization of the panels. Others are shown below. 

 

 

 

Phase 4: The Velocity Manipulation module is a stand-aloneo module used for smoothing the velocity 

picks, as well as for transforming the velocity analysis from RMS to Interval or Average, or to switch 

between Time and Depth. Here it is used to smooth the velocity model. Note that this not necessary, but 

it is good to distribute the velocity values along the data. As ‘First Input velocity’ select the generated 

velocity file, choose the velocity domain and type. Give a name in the ‘Output velocity’ tab and select the 



desired domain and type. Fill the ‘Interpolate and smooth output velocity’ parameters as desired 

(suggested values shown below)  

 

 

 

Displaying the velocity model is not mandatory, but helps to QC the velocity distribution across the data. 

The Brute Stack dataset is selected as Trace Input, sorted as CDP:OFFSET. In the Screen Display, the 

‘Display velocity’ option should be selected, located under the ‘Data/Velocity’ tab. Click on ‘Set Velocity’ 

and open the manipulated velocity file, set the minimum and maximum velocity values on the palette 

range fileds. 

 



 

 

Result 

 
Figure A.13. Velocity distribution changing with time on CDPs.  

 

  



11 – STACK 

Now that the velocities are available, NMO/NMI corrections can be applied to the data to create the CDP 

stack. The input file in the Trace Input module is the output of the wavefield subtraction flow (see 

section 9). Output is named as 5-stack. 

 

 

On the ‘NMO’ tab you may wish to set a ‘Mute percent’ (suggested value: 30). This is the stretch muting 

parameter: parts of the trace that are stretched by more than 30% because of the NMO-correction will 

be muted out. This also allows to mute the direct wave out (although in this data it is not that important, 

since the direct wave is not interfering with the data anyway).  

 

 

 



Result 

 
Figure A.14. Stack Output of line BX2500. 

 

  



12- DE-GHOSTING 

De-ghosting is applied to eliminate the effects of ghost reflections, which are unwanted duplicates of the 

primary seismic signal that have a negative impact on the resolution of the data. 

 

Trace Input uses the CDP stack data. For the flow to work correctly, the FBPICK values need to be shifted 

down using the Trace Header Math module. Predictive Deconvolution uses the FBPICK (seafloor horizon) 

and ENS_END (record length) headers as time window parameters. ‘Prediction gap’ value and 

‘deconvolution operator length’ are 1ms and 2ms, which are the 1st and 2nd intersection of the 

autocorrelation with the zero axis. Bandpass filtering is added for removing residual noise after 

deconvolution. Also reset the FBPICK values via the Trace Header Math module and generate the output. 

 

 

 

 



Result 

 
Figure A.15. De-ghosting processing Output of line BX2500. The main effect of the processing can be 
observed just below the seafloor when comparing stack output (in the previous chapter). 

  



13 – PREDICTIVE DECONVOLUTION FOR MULTIPLE SUPPRESSION 

This process aims to remove the 1st and 2nd seabed multiple from the stacked data by predictive 

deconvolution.  

 

 

The FBPICK header contains the seafloor picking values, which are here used as ‘Prediction Gap’ 

parameter in the deconvolution and as ‘time window starting’ parameter as well. ‘Deconvolution operator 

length’ determines how much data will be rejected from the trace, in ms starting from the beginning of 

the multiple. The most appropriate value should be established by testing with different inputs. Since the 

first multiple of the seafloor has a very strong reflection, the predictive deconvolution process is applied 

twice (consecutively) to eliminate it from the data. The second predictive deconvolution uses the same 

parameters as the first has. 

 



An additional (single) predictive deconvolution module is applied to eliminate the second seafloor 

multiple. This requires multiplying the FBPICK header by two (the result is assigned to the PICK1 header). 

This header is now used as ‘Prediction gap’ value, which is the only difference from the first two 

deconvolution modules. 

 

 

The F-X Predictive Filtering and TFD Noise Attenuation modules are applied for removing noises after 

applying the deconvolution. The processing time window interval in TFD is set to the interval between 

The first multiple observation time and the end of the recording. The optimal parameters are shown 

below: 

 

 



Result 

 

 
Figure A.16. The top seismic output shows the data before the processing flow, the bottom picture shows 
the data after the processing flow. 

 

  



14 – POST-STACK TIME MIGRATION 

Migration is needed to place reflection boundaries to their real positions. The Kirchhoff Migration module 
is used, as it allows both vertical and lateral changes in migration velocities. This is a stand-alone module. 
 

 
 
Select decon after stack data (7-decon_afstk) as the input dataset. The Migration velocity file is selected 
from the database. The ‘X step’ is the spatial increment between traces, it shall be equal to the CDP 
spacing (bin size) that is 1 m. Values for the other parameters are suggested below:  

 

 
 

 

 

 

 

 

 

 

  

 



Result  

 

 
 

 
          Figure A.17. Before (top) and after (bottom) migration. 

 

                

 

  



15 – FINAL DISPLAY 

Automatic Gain Control and Trace Editing (top mute) modules are applied, respectively, to equalize the 
amplitude distribution of the migration output and erase noise in the water column. The FBPICK value is 
shifted slightly upwards to prevent cutting off the seafloor using the Trace Header Math module. 
 

 
 

 
 

 
 

 
 

 

 

 

 

 

 



Result 

 
 

 
    Figure A.18. Before AGC + MUTE (top), after AGC + MUTE (bottom). 



16 – TIDE CORRECTION & SEGY OUTPUT 

Before exporting the processed seg-y file, the tidal correction must be applied. First, tidal values are 
imported into the data via the stand-alone Tides Import module. In the ‘Input parameters’ tab, select the 
fully processed dataset. In the ‘Tides’ tab, the txt file containing the tidal values at project area and time, 
is called by pressing the Files button. By clicking Edit File Layout, the column spacing values of this txt file 
can be adjusted. In the ‘Headers’ tab, it is defined to which header the tide values will be. Then, this header 
is used in the Apply Statics module.  
 

 
 

 
 

 
 
 



 
 

To apply the static correction, the tide values first need to be converted from meters to milliseconds (time) 
using the Trace Header Math module. Then use the Apply Statics module to subtract the tidal height 
(make sure to select the ‘Subtract static’ option). 
 

 
 

 
 

The last step of the process is to generate a Seg-Y output of the processed data using the Seg-Y Output 
module. Give a name for the SEGY file. Scalars are set to -100, meaning that the values of the headers 
listed in ‘Multiplied Fields’ will be divided by 100.  



 

 

 
 

Overview of exported files: 

1) final: No Decon, No AGC 

2) final+decon: Decon, No AGC final+decon 

3) final+decon+agc: AGC + Decon 

Overview of most important header byte numbers: 

* shot number (FFID): byte 9 
* Source coordinates: bytes 73 and 77 (in WGS84-UTM31, scalar = 0.01) 
* Receiver coordinates: bytes 81 and 85 (in WGS84-UTM31, scalar = 0.01) 
* CDP number: byte 21 
* CDP coordinates: bytes 181 and 185 (in WGS84-UTM31, scalar = 0.01) 



Appendix B. Detailed workflow for the processing of parametric sub-bottom profiling data 

  



1. PRE-PROCESSING OF DATA IN INNOMAR FORMAT (ISE software) 

The heading was recorded in SESWIN acquisition during the survey, with the motion sensor getting 

heading aiding by the VLIZ (portable) Septentrio GPS. The online calculated (offset) positions show 

occasional outliers due to input of erroneous heading values. Therefore, the offset calculation is revised 

in the processing using the Octans heading (logged in MIDAS), before the conversion to seg-y format.  

 
1.1 Import heading into SIS field 4 (SES3 format) 

This overwrites the values in SIS field 4 (GPS quality) with the heading values from the Octans, based on 

the time stamp.  

(PROCEESING > REPLACE SIS) – select import file with new SIS data (CHOOSE TXT DATA ARRANGED WITH 

EXCEL AS DATE, HOUR, COURSE GROUND OVER AND TURNED TO TXT). Example txt output should be:  

03.04.2023 08:57:25 322.21 

03.04.2023 08:57:30 321.67 

 

 

 

 

Note: formatting of import text file: 

- no title above columns! 

- date as dd.mm.yyyy (year with four digits!) 

- time as hh:mm:ss 

 

 



 

 

CLICK ‘CHECK IMPORT FILE’!! 



 

 



 

 

1.2 Convert the Lat/Lon in SIS field 1 (i.e. ship’s GPS) to UTM (SES3 format) 

This overwrites the original (but imprecise) UTM X/Y positions of the PES in SIS fields 7 and 8 (calculated 

online), with the UTM X/Y positions of the ship’s GPS  

(PROCESSING > COORDINATE TRANSFORMATION) 

(CHOOSE THE DATA STARTS WITH 1_ PREFIX, PUT `2` AS PREFIX) 



 

Note: don’t forget to select the correct coordinate system in the second tab (default value is often wrong!) 

 

 



1.3. Offset coordinates in SIS field 7/8 to the location of the PES (SES3 format) 

This overwrites the UTM X/Y positions of the ship’s GPS in SIS fields 7 and 8 with the UTM X/Y positions 

of the PES, based on the measured GPS-PES offset and the imported (precise) heading values 

(PROCESSING >PROCESS SIS> OFFSET COORDINATES> after finish arrangement and select data PRESS 

OFFSET) 

 

 

Note: if SES ID Z-position = 3 (i.e. SIS field where the time stamp is saved), the leading zeroes in the time 

stamp get erased for some reason, even if the tick box (next to SIS ID Z-position) in the above window is 

not checked → Make sure this field is not = 3! 

MAX MIN Coordinates  

Open data in GIS extension and check the min x,y max x,y coordinates of the data. If see any anomaly in 

the lines or as a point, if it is not big we can delete that data fram folder. 

1.4. Clip coordinates (SES3 format) 

This step is performed to delete potential coordinate outliers (zero values) from the data. The bounding 

box spans the overall survey area. (PROCESSING > PROCESS SIS > CLIP COORDINATE) 



 

 

1.5. Conversion to .raw files (RAW format) 

The corrected .ses3 files can now be converted to .raw format (note that .raw files are smaller in size). 

Coordinates are not interpolated in this step, but later (see step 7 and conversion to .sgy), meaning that 

the individual .raw files are not interpolated. 



 

 



1.6. Interpolate raw files (RAW format) 

Copy and paste new  data  starts with 1_4321.. and rename all files like being ‘CT-LOTE23-

04_20230404_060211’ 

This erases remaining ‘empty traces’: in Innomar software they are recognized as empty and hence don’t 

appear in the GIS box, but when converted to seg-y with interpolation, they are taken into account which 

leads to bad navigation in the resulting seg-y!  

 

 

 

 

 

 

 

 

 

 

 



2. CONVERSION TO SEG-Y (SESconvert software) 

Finally, the interpolated .raw files are converted to seg-y, with following settings: 

 

 



3. FURTHER PROCESSING IN RadExPro 

3.1- DATA INPUT (Batch Mode) 

 

SEG-Y Input:  Batch list is used to input multiple SEG-Y files at once and convert them to the RadExPro 

internal format. 

 

Trace Output: create files in RadExPro format. 

 



3.2- NAVIGATION QC  

 

Trace Input: Add the datasets in the project and choose ‘Load headers only’. 

 

 

Note: If the number of files is bigger than 100, the software runs into an error.  

Therefore, load the files per 100 and give names (e.g. merge1, merge2, …) as output. 

 

 

Trace Output  

 
 

 

 

 

 



CrossPlot*: Standalone module. You can plot the shot navigation using SOU_X (x-axis) and SOU_Y (y-

axis). This helps to verify potential navigation issues in the headers. 

 

 
 

 

 

 



3.3-TIDE IMPORT 

 

 

 

 

Tide Import*: Import tide information gathered from tidal stations or measured by a RTK GNSS 

 

 

 

 



3.4- FILTERING 

The main processing flow consists of (i) filtering, which aims to improve the signal/noise ratio, and (ii) tidal 

correction, which corrects the data for variations in tidal height during acquisition. It is recommended to 

first test the filters on one or a few lines. Once satisfactory results are achieved, the flow can be executed 

in batch mode to apply the processing to all files at once.  

 

 

 

Filter parameters are tested using a line. 

 

 

 

Burst Noise Removal: The module is designed for removal of high-amplitude noise bursts from the seismic 

traces. This module also helps to remove/attenuate marine swell noise and similar types of noise bursts, 

and to remove interference from the (simultaneously deployed) sparker source. 

 

 

 



Result 

 

 

 

Figure B.01. The top seismic view is before applying Burst removal noise filter to the test line. The middle 
view is after applying the filter and the bottom view is the difference between filtering and no filtering 
data. 

 

 



2D Spatial Filtering: Test and apply different values to finetune the data output in function of the goal of 

the research. If more detail needs to be preserved in the data (at the cost of also keeping more noise), the 

‘Number of traces and samples’ values should be reduced. 

 

 

 

Result 

 

 

 

 

 

 

 

Figure B.02. Display of a 2D Spatial Filtering applied PES line. 



Amplitude Correction  

 

 

Result 

 

Figure B.03. The result of the Amplitude correction selecting Time raised power option. 

 

 

 

 

 



3.5- TIDAL CORRECTION 

To prevent cutting off data at the top or bottom of the profiles when applying the tidal correction, a new 

appropriate trace length is assigned using Trace Length module. The recorded PES data trace length is 37 

ms, to which 8 ms is added; the new trace length is thus 45 ms. 

 
 

 

 

Figure B.04. Add the trace length before and after. The recording time is extended by 8 ms from the point 
where the data length ends. 

 



The difference between the new and the old trace length is assigned as a new header called PICK1 in Trace 

Header Math module. 

 

 

Apply Statics (First): The PICK1 value is used as input in a first static correction (downward shift of the 

data). This step ‘creates space’ for the tidal height to be subtracted in the next step.  

 

 

 

Figure B.05. The new trace length data (left) and the data after applying static correction (right) are shown 
above. 



In the Tidal Import module, the tidal data were assigned to the STAT1 header. Since these values are 

expressed in m above LAT, a conversion to ms TWTT (assigned to STAT2) is required, for which the Trace 

Header Math (second) module is used: 

STAT2 = (2*STAT1) / 1.5   

 

 

 

The value in STAT2 is now used in the Apply Statics (second) module. Important: this value needs to be 

subtracted from the data (i.e. upward shift). As such, variations in tidal height during data acquisition or 

corrected for. 

 

 

 

 

 



 

Figure B.06. Tidal correction in millisecond  

In the final step, the first downward static shift (stored in PICK1) is compensated, by subtracting this value 

from the DELAY using Trace Header Math (second). As such, the only static completed at the end of this 

flow, is the tidal correction. 

 

 

 

 

 

 



3.6- SEG-Y OUTPUT 

Firstly, open the batch mode to select all datasets and arrange the Trace Input module as shown below. 

Then activate all modules in the flow (except Screen display) with the parameters as established above.  

 

 

 

Select the option ‘From batch list’ and define the file location and suffix. Scalars of 0.01 are used (so enter 

value -100) and the DELAY header is remapped to byte 109 (2 byte Integer). 

 

 

Overview of exported files: 

* Big-endian byte order  

* FFID in byte 9 

 * X in byte 73 (scalar = 0.01) 

 * Y in byte 77 (scalar = 0.01) 

 * DELAY in byte 109 


